Ex No : 1	 COMPONENT DEVELOPMENT USING .NET TECHNOLOGY
A component is a special type of executable built from a .NET project. In-Process Components are .NET components built as DLLs run within the process space of the host application and share memory and processor time with their host applications. 
SOFTWARE REQUIREMENTS
Microsoft Visual Studio 2008 Version 9.0.21022.8 RTM
Microsoft .NET Framework Version 3.5
Installed Edition: Enterprise
PROCEDURE 
I. Creating the Component
Follow these steps to build a .NET DLL component 
1. Start Visual Studio .NET and open a new Class Library project. In the New Project dialog box, name the project. 
2. Change the name of the class from Class1 to Component name (for eg TimeComp, InterestComp)
3. Enter the Component code into the new class module.
4. Compile this class as a DLL by clicking Build on the Debug menu or by using the Ctrl+Shift+B keystroke combination.
The DLL that results from the build command is placed into the \bin directory immediately below your .NET project directory. By default, the DLL has the same name as your component project. 
[image: ]
II 	Creating the Application
Once the DLL project has been compiled, its services are available to any Windows Form .NET application. Follow these steps to create the client application: 
1. Start Visual Studio .NET, select Windows Application as the new project type, and name the project. 
2. Set the Name property of the default Windows Form(for eg frmConsumer, intrfrm)
3. Design the Form by placing controls and naming them.
4. You need to set a reference to the DLL so that this form will be able to consume the components services. 
5. Do this by following the steps below. 
6. From the Project menu, click Add Reference. 
[image: ]
1. Click the Browse tab to locate the component DLL built. 
[image: ]
Figure 1. The .NET tab in the Add Reference dialog box 
[image: http://i.msdn.microsoft.com/ms973807.componentsnet02(en-us,MSDN.10).gif]
Figure 2. Selecting a DLL reference 
2. Select the .DLL file, click Open, and then click OK. 
The Solution Explorer, as shown in Figure 3, now shows the component added as a reference in your application. What this means is that all of the classes, along with their properties, methods, and events, are now available to your consumer application.
[image: http://i.msdn.microsoft.com/ms973807.componentsnet03(en-us,MSDN.10).gif]
Figure 3. Solution Explorer showing all current references
3. Enter the Application code.
4. Run the application by pressing F5 function key or Start Debugging from Debug Menu
EX 1.1 : 		TIME STAMP COMPONENT USING .NET
DATE : 
COMPONENT CODE
Public Class ServerTime

 Private mdtTime As DateTime
	 ReadOnly Property TimeStamp() As String
		 Get
		      mdtTime = Now()
 		      Return CStr(mdtTime)
		 End Get

   End Property

End Class

APPLICATION CODE
Public Class TimeFrm

Private Sub btnGetServerTime_Click( _ ByVal sender As System.Object, _ ByVal e As System.EventArgs) _ Handles btnGetServerTime.Click
	
	  Dim st As New ServerTime.ServerTime
	  txtServerTime.Text = st.TimeStamp

End Sub

End Class

FORM DESIGNING
[image: ]
Label		:  Property : Text – Time Stamp Component
Button		:  Property: Name – btnGetServerTime
	               Text – Get Server Time
Text Box 	: Property: Name – txtServerTime
OUTPUT
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EX 1.2		INTEREST CALCULATION COMPONENT USING .NET
DATE : 
COMPONENT CODE
Public Class InterestComp

    Private intSI As Double
    Private intCI As Double

    ReadOnly Property SimpleInt(ByVal p As Integer, ByVal n As Integer, ByVal r As Integer) As String
        Get
            intSI = (p * n * r) / 100
            Return CStr(intSI)
        End Get
    End Property
  
  ReadOnly Property CompoundInt(ByVal p As Integer, ByVal n As Integer, ByVal r As Integer) As String
        Get
            intCI = p * (((1 * r) ^ n) / 100)
            Return CStr(intCI)
        End Get
    End Property

End Class

APPLICATION CODE
Public Class IntcalFrm

    Private p As Integer
    Private n As Integer
    Private r As Integer
    Dim intcal As New InterestComp.InterestComp

Private Sub butSI_Click(ByVal sender As System.Object, ByVal e As System.EventArgs) Handles butSI.Click
        p = Integer.Parse(txtP.Text)
        n = Integer.Parse(txtN.Text)
        r = Integer.Parse(txtR.Text)
        txtSI.Text = CStr(intcal.SimpleInt(p, n, r))
    End Sub

Private Sub butCI_Click(ByVal sender As System.Object, ByVal e As System.EventArgs) Handles butCI.Click
        p = Integer.Parse(txtP.Text)
        n = Integer.Parse(txtN.Text)
        r = Integer.Parse(txtR.Text)
        txtCI.Text = CStr(intcal.CompoundInt(p, n, r))
    End Sub

End Class

FORM DESIGNING
[image: ]
Label		:  Property : Text – INTEREST CALCULATION FORM, Principle, Rate
				       No of Years, Simple Interest, Compound Interest	
Button		:  Property: Name – butSI, butCI
	               Text – Calculate SI, Calculate CI
Text Boxes 	: Property: Name – txtP, txtN, txtR, txtCI, txtSI





OUTPUT
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EX 1.3			ORDER PROCESSING COMPONENT USING .NET
DATE : 

APPLICATION CODE
Public Class FillOrderForm
    Dim inc As Integer
    Dim con As New OleDb.OleDbConnection
    Dim ds As New DataSet
    Dim da As OleDb.OleDbDataAdapter
    Dim sql As String
    Dim dbProvider As String
    Dim MaxRows As Integer
    Dim dbSource As String
    Dim cb As New OleDb.OleDbCommandBuilder(da)
    Dim dsNewRow As DataRow

Private Sub FillForm_Load(ByVal sender As System.Object, ByVal e As   System.EventArgs) Handles MyBase.Load
con.ConnectionString = "PROVIDER=Microsoft.Jet.OLEDB.4.0; Data Source=C:\Documents and Settings\student\My Documents\Visual Studio 2008\AddressBook.mdb"
        con.Open()
        Sql = "SELECT * FROM tblContacts"
        da = New OleDb.OleDbDataAdapter(Sql, con)
        da.Fill(ds, "AddressBook")
        txtFirstName.Text = ds.Tables("AddressBook").Rows(0).Item(1)
        txtSurname.Text = ds.Tables("AddressBook").Rows(0).Item(2)
        Address1.Text = ds.Tables("AddressBook").Rows(0).Item(3)
        Address2.Text = ds.Tables("AddressBook").Rows(0).Item(4)
        Address3.Text = ds.Tables("AddressBook").Rows(0).Item(5)
        PhoneTB.Text = ds.Tables("AddressBook").Rows(0).Item(6)
        ItemCB.Text = ds.Tables("AddressBook").Rows(0).Item(7)
        NoUTB.Text = ds.Tables("AddressBook").Rows(0).Item(8)
        DateTimePicker1.Text = ds.Tables("AddressBook").Rows(0).Item(9)
        CostTB.Text = ds.Tables("AddressBook").Rows(0).Item(10)
        Totcost.Text = ds.Tables("AddressBook").Rows(0).Item(11)
        MsgBox("Database is now open")
        con.Close()
        MaxRows = ds.Tables("AddressBook").Rows.Count
        inc = -1
        MsgBox("Database is now Closed")
    End Sub

    
Private Sub NavigateRecords()
        txtFirstName.Text = ds.Tables("AddressBook").Rows(inc).Item(1)
        txtSurname.Text = ds.Tables("AddressBook").Rows(inc).Item(2)
        Address1.Text = ds.Tables("AddressBook").Rows(inc).Item(3)
        Address2.Text = ds.Tables("AddressBook").Rows(inc).Item(4)
        Address3.Text = ds.Tables("AddressBook").Rows(inc).Item(5)
        PhoneTB.Text = ds.Tables("AddressBook").Rows(inc).Item(6)
        ItemCB.Text = ds.Tables("AddressBook").Rows(inc).Item(7)
        NoUTB.Text = ds.Tables("AddressBook").Rows(inc).Item(8)
        DateTimePicker1.Text = ds.Tables("AddressBook").Rows(inc).Item(9)
        CostTB.Text = ds.Tables("AddressBook").Rows(inc).Item(10)
        Totcost.Text = ds.Tables("AddressBook").Rows(inc).Item(11)
    End Sub

Private Sub Nextbtn_Click(ByVal sender As System.Object, ByVal e As System.EventArgs) Handles Nextbtn.Click
        If inc <> MaxRows - 1 Then
            inc = inc + 1
            NavigateRecords()
        Else
            MsgBox("No More Rows")
        End If
    End Sub

Private Sub Prevbtn_Click(ByVal sender As System.Object, ByVal e As System.EventArgs) Handles Prevbtn.Click
        If inc > 0 Then
            inc = inc - 1
            NavigateRecords()
        Else
            MsgBox("First Record")
        End If
    End Sub

    Private Sub Lastbtn_Click(ByVal sender As System.Object, ByVal e As System.EventArgs) Handles Lastbtn.Click
        If inc <> MaxRows - 1 Then
            inc = MaxRows - 1
            NavigateRecords()
        End If
    End Sub

 Private Sub Firstbtn_Click(ByVal sender As System.Object, ByVal e As System.EventArgs) Handles Firstbtn.Click
        If inc <> 0 Then
            inc = 0
            NavigateRecords()
        End If
    End Sub

 Private Sub Updatebtn_Click(ByVal sender As System.Object, ByVal e As System.EventArgs) Handles Updatebtn.Click
        Dim cb As New OleDb.OleDbCommandBuilder(da)
        ds.Tables("AddressBook").Rows(inc).Item(1) = txtFirstName.Text
        ds.Tables("AddressBook").Rows(inc).Item(2) = txtSurname.Text
        ds.Tables("AddressBook").Rows(inc).Item(3) = Address1.Text
        ds.Tables("AddressBook").Rows(inc).Item(4) = Address2.Text
        ds.Tables("AddressBook").Rows(inc).Item(5) = Address3.Text
        ds.Tables("AddressBook").Rows(inc).Item(6) = PhoneTB.Text
        ds.Tables("AddressBook").Rows(inc).Item(7) = ItemCB.Text
        ds.Tables("AddressBook").Rows(inc).Item(8) = NoUTB.Text
        ds.Tables("AddressBook").Rows(inc).Item(9) = DateTimePicker1.Text
        ds.Tables("AddressBook").Rows(inc).Item(10) = CostTB.Text
        ds.Tables("AddressBook").Rows(inc).Item(11) = Totcost.Text
        da.Update(ds, "AddressBook")
        MsgBox("Data was updated")
    End Sub
 
   Private Sub Addbtn_Click(ByVal sender As System.Object, ByVal e As System.EventArgs) Handles Addbtn.Click
        Commitbtn.Enabled = True
        Addbtn.Enabled = False
        Updatebtn.Enabled = False
        Deletebtn.Enabled = False
        txtFirstName.Clear()
        txtSurname.Clear()
        CostTB.Clear()
        NoUTB.Clear()
        Address1.Clear()
        Address2.Clear()
        Address3.Clear()
        Totcost.Clear()
        DateTimePicker1.Clear()
        PhoneTB.Clear()
        ItemCB.Clear()
    End Sub

    Private Sub Deletebtn_Click(ByVal sender As System.Object, ByVal e As System.EventArgs) Handles Deletebtn.Click
        Dim cb As New OleDb.OleDbCommandBuilder(da)
        ds.Tables("AddressBook").Rows(inc).Delete()
        MaxRows = MaxRows - 1
        da.Update(ds, "AddressBook")
        MessageBox.Show("The Current Record Was deleted", "Delete Dialog Box", MessageBoxButtons.OK)
        inc = 0
        NavigateRecords()
    End Sub

    Private Sub Clearbtn_Click(ByVal sender As System.Object, ByVal e As System.EventArgs) Handles Clearbtn.Click
        Commitbtn.Enabled = False
        Addbtn.Enabled = True
        Updatebtn.Enabled = True
        Deletebtn.Enabled = True
        inc = 0
        txtFirstName.Clear()
        txtSurname.Clear()
        CostTB.Clear()
        NoUTB.Clear()
        Address1.Clear()
        Address2.Clear()
        Address3.Clear()
        Totcost.Clear()
        PhoneTB.Clear()
        DateTimePicker1.Clear()
        ItemCB.Clear()
    End Sub

    Private Sub Commitbtn_Click(ByVal sender As System.Object, ByVal e As System.EventArgs) Handles Commitbtn.Click
        If inc <> -1 Then
            Dim cb As New OleDb.OleDbCommandBuilder(da)
            Dim dsNewRow As DataRow
            dsNewRow = ds.Tables("AddressBook").NewRow()
            MessageBox.Show("welcome")
            dsNewRow.Item("Fname") = txtFirstName.Text
            dsNewRow.Item("Sname") = txtSurname.Text
            dsNewRow.Item("Address1") = Address1.Text
            dsNewRow.Item("Address2") = Address2.Text
            dsNewRow.Item("Address3") = Address3.Text
            dsNewRow.Item("Phone") = PhoneTB.Text
            dsNewRow.Item("Item") = ItemCB.Text
            dsNewRow.Item("NoOfUnits") = NoUTB.Text
            dsNewRow.Item("datetime") = DateTimePicker1.Text
            dsNewRow.Item("Cost") = CostTB.Text
            dsNewRow.Item("Totcost") = Totcost.Text
            ds.Tables("AddressBook").Rows.Add(dsNewRow)
            da.Update(ds, "AddressBook")
            MsgBox("New Record added to the Database")
            Commitbtn.Enabled = False
            Addbtn.Enabled = True
            Updatebtn.Enabled = True
            Deletebtn.Enabled = True
        End If
    End Sub
End Class

FORM DESIGNING
[image: ]


Label		:  Property : Text – FName, SName, Address, City, State, Phone No, Date, Item, 
				       No of Units, Cost, Tot Cost
Button		:  Property: Name – Commitbtn, Addbtn, Updatebtn, Deletebtn,
        Clearbtn, Lastbtn, Prevbtn, Nextbtn
	             : Text – <<, <, >, >>, ADD, DELETE, COMMIT, UPDATE, CLEAR
Text Boxes 	: Property: Name – txtFirstName, txtSurname, Address1, Address2, Address3,
				       PhoneTB, ItemCB, DateTimePicker1, CostTB, Totcost







ADDING DATA SOURCE

1. Create the table in MS-Access with the following fields
MS-Access Database name : AddressBook.mdb            Table name : tblContacts
[image: ]

2. Select Add New Data Source from Data menu

[image: ]


3. Select Database and Click Next

[image: ]

4. Choose New Connection and clcik Browse to select the database you have created

[image: ]
 
Also Test the Connection by clicking Test Connection button


[image: ]
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5. Check the box near the tblContacts and click Finish button

[image: ]

6. Database connection is added to our project and it can be seen by selecting Server Explorer form VIEW menu

[image: ]

7. Build and Execute the Project.

OUTPUT :
ADDING NEW ORDER
[image: ]
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MODIFYING AN ORDER
[image: ]

DELETING AN ORDER
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Ex No : 1.4 		TEMPERATURE CONVERSION COMPONENT USING .NET
DATE : 
COMPONENT CODE (TempConv.vb)
Public Class TempConv
    Private fah As Double
    Private cel As Double
    ReadOnly Property FahToCel(ByVal f As Integer) As String
        Get
            cel = (f - 32) * 5 / 9
            Return CStr(cel)
        End Get
    End Property
    ReadOnly Property CelToFah(ByVal c As Integer) As String
        Get
            fah = (c * 9 / 5) + 32
            Return CStr(fah)
        End Get
    End Property
End Class
APPLICATION CODE (TempForm.vb)

Public Class TempForm
    Dim temcal As New TempConv.TempConv
    Dim f As Integer
    Dim c As Integer

    Private Sub butFtoC_Click(ByVal sender As System.Object, ByVal e As System.EventArgs) Handles butFtoC.Click
        If txtConvert.Text = "" Then
            MsgBox("Enter the value to convert")
            txtConvert.Focus()
        Else
            butCtoF.Enabled = False
            lblEnter.Text = "Temperature in Fahrenheit"
            lblDisplay.Text = "Temperature in Celcius"
            f = Integer.Parse(txtConvert.Text)
            txtDisplay.Text = temcal.FahToCel(f)
        End If

    End Sub


    Private Sub butCtoF_Click(ByVal sender As System.Object, ByVal e As System.EventArgs) Handles butCtoF.Click
        If txtConvert.Text = "" Then
            MsgBox("Enter the value to convert")
            txtConvert.Focus()
        Else
            butFtoC.Enabled = False
            lblEnter.Text = "Temperature in Celcius"
            lblDisplay.Text = "Temperature in Fahrenheit"
            c = Integer.Parse(txtConvert.Text)
            txtDisplay.Text = temcal.FahToCel(c)
        End If
    End Sub

    Private Sub butClear_Click(ByVal sender As System.Object, ByVal e As System.EventArgs) Handles butClear.Click
        butCtoF.Enabled = True
        butFtoC.Enabled = True
        lblEnter.Text = "Enter the Temperature"
        lblDisplay.Text = "Converted Temperature"
        txtConvert.Text = ""
        txtDisplay.Text = ""
    End Sub
End Class

FORM DESIGNING
[image: ]

Label		:  Property : Text – Enter the Temperature, Converted Temperature 
			        Name -- lblEnter, lblDisplay
Button		:  Property: Name – butFtoC, butCtoF, butClear
	             : Text –  Convert Fahrenheit To Celcius, Convert Celcius To Fahrenheit
Text Boxes 	: Property: Name – txtConvert, txtDisplay
OUTPUT :
Fahrenheit to Celcius
[image: ]
Celcius to Fahrenheit
[image: ]

Ex. No. : 1.5		CURRENCY CONVERTER COMPONENT USING .NET
DATE : 
COMPONENT CODE
Public Class CurrConv
    Public convAmt As Decimal
    Public amount As Decimal
    '1 Indian Rupee  = 0.01558 Euro 
    '1 Euro(EUR)  = 64.20290 Indian Rupee (INR) 

    '1 Indian Rupee  = 0.00604 Kuwaiti Dinar 
    '1 Kuwaiti Dinar(KWD)  = 165.61900 Indian Rupee (INR) 

    '1 Indian Rupee  = 0.02206 US Dollar 
    '1 US Dollar(USD)  = 45.32500 Indian Rupee (INR) 

    '1 Indian Rupee  = 0.01367 British Pound 
    '1 British Pound(GBP)  = 73.16090 Indian Rupee (INR) 

    '1 Euro  = 0.38765 Kuwaiti Dinar 
    '1 Kuwaiti Dinar(KWD)  = 2.57962 Euro (EUR 

    '1 Euro  = 1.41650 US Dollar 
    '1 US Dollar(USD)  = 0.70596 Euro (EUR) 
    '1 Euro  = 0.87756 British Pound 
    '1 British Pound(GBP)  = 1.13953 Euro (EUR) 
    '  1 Kuwaiti Dinar  = 3.65403 US Dollar 
    '1 US Dollar(USD)  = 0.27367 Kuwaiti Dinar (KWD) 

    '1 Kuwaiti Dinar  = 2.26376 British Pound 
    '1 British Pound(GBP)  = 0.44174 Kuwaiti Dinar (KWD) 
    '1 US Dollar  = 0.61952 British Pound 
    '1 British Pound(GBP)  = 1.61414 US Dollar (USD) 

    ReadOnly Property ConvFromTo(ByVal cf As String, ByVal ct As String, ByVal amt As String) As String
        Get
            amount = Double.Parse(amt)
            Select Case (cf)
                Case "Rupee"
                    Select Case (ct)
                        Case "Euro"
                            convAmt = amount * 0.01558
                        Case "Dinar"
                            convAmt = amount * 0.00604
                        Case "Dollar"
                            convAmt = amount * 0.02206
                        Case "Pound"
                            convAmt = amount * 0.01367
                    End Select
                Case "Euro"
                    Select Case (ct)
                        Case "Rupee"
                            convAmt = amount * 64.2029
                        Case "Dinar"
                            convAmt = amount * 0.38765
                        Case "Dollar"
                            convAmt = amount * 1.4165
                        Case "Pound"
                            convAmt = amount * 0.87756
                    End Select
                Case "Dinar"
                    Select Case (ct)
                        Case "Rupee"
                            convAmt = amount * 165.619
                        Case "Euro"
                            convAmt = amount * 2.57962
                        Case "Dollar"
                            convAmt = amount * 3.65403
                        Case "Pound"
                            convAmt = amount * 2.26376
                    End Select
                Case "Dollar"
                    Select Case (ct)
                        Case "Rupee"
                            convAmt = amount * 45.325
                        Case "Euro"
                            convAmt = amount * 0.70596
                        Case "Dinar"
                            convAmt = amount * 0.27367
                        Case "Pound"
                            convAmt = amount * 0.61952
                    End Select
                Case "Pound"
                    Select Case (ct)
                        Case "Rupee"
                            convAmt = amount * 73.1609
                        Case "Euro"
                            convAmt = amount * 1.13953
                        Case "Dinar"
                            convAmt = amount * 0.44174
                        Case "Dollar"
                            convAmt = amount * 1.61414
                    End Select
            End Select
            Return CStr(convAmt)
        End Get
    End Property
End Class

APPLICATION CODE

Public Class Curr
    Dim curconv As New CurrConv.CurrConv
    Dim amount As Decimal
    Private Sub butConvert_Click(ByVal sender As System.Object, ByVal e As System.EventArgs) Handles butConvert.Click
        ' declare variables
        amount = curconv.ConvFromTo(curFrom.SelectedItem, curTo.SelectedItem, amtext.Text)
        'assign result to corresponding label
        ConvAmtLabel.Text = amtext.Text + curFrom.SelectedItem + "=" + String.Format("{0:F}", amount) + curTo.SelectedItem
    End Sub

End Class ' CurrencyConverterForm





















FORM DESIGNING 

Label	:  Property : Text –  Currency From, Currency To, Amount To Convert, 
			        Converted Amount, CUURENCY CONVERSION
		        Name -- ConvAmtLabel
Button		:  Property: Name – butConvert
	           : Text – <<, <, >, >>, ADD, DELETE, COMMIT, UPDATE, CLEAR
Text Box	: Property: Name – amtext
List Box	: Property: Name – curFrom, curTo

[image: ]
















OUTPUT :  
From Dollor To Rupees
[image: ]
From Rupees To Dollors
[image: ]

Ex No : 2	 COMPONENT DEVELOPMENT USING EJB TECHNOLOGY

SOFTWARE REQUIREMENTS

Java(TM) 2 SDK, Standard Edition Version 1.2.2 Folder: C:\jdk1.2.2
Java(tm) 2 SDK, Enterprise Edition Version:  1.2.1 Folder: C:\j2sdkee1.2.1

Configuring the Software

1. Open the file setenv.bat that is present in the c:\j2sdkee1.2.1\bin
Set JAVA_HOME and J2EE_HOME as given below
		JAVA_HOME=c:\jdk1.2.2
		J2EE_HOME= c:\j2sdkee1.2.1
Save the file and close it.

2. Setting the Windows NT Environmental variables
Choose Start Settings  Control Panel
Click on the Systems icon
Choose Environment Variables tab in Advanced Tab
Click on PATH and add the following path in the system variable.
			 ;C:\jdk1.2.2\bin;C:\j2sdkee1.2.1\bin
Click on New Button to create the new system variable
Click on CLASSPATH and add the following line in classpath
			C:\jdk1.2.2\lib;C:\j2sdkee1.2.1\lib\j2ee.jar


[image: ]


EX NO:  2.1 			ADDITION COMPONENT USING EJB
DATE:

AIM:
     To develop an EJB component for simple arithmetic addition operator.

PROCEDURE:

STEP 1:  Write the source code for the remote interface for EJB and save it as addremote.java

// addremote.java
import javax.ejb.*;
import java.rmi.*;
public interface addremote extends EJBObject
{
public int add(int a, int b) throws RemoteException;
}

STEP 2: Write the source code for home interface called addhome.java

// addhome.java
import javax.ejb.*;
import java.rmi.*;
public interface addhome extends EJBHome
{
addremote create() throws RemoteException, CreateException;
}

STEP 3: Write the source code for Stateless Session Bean class and save it as addbean.java
// addbean.java
import javax.ejb.*;
import java.rmi.*;
import java.util.*;

public class addbean implements SessionBean
{
	public int add(int a, int b) throws RemoteException
	{
	return a+b;
	}
public void ejbCreate() {}
public void ejbRemove() {}
public void ejbActivate() {}
public void ejbPassivate() {}
public void setSessionContext(SessionContext sc) {}
}
STEP  4:  Write the compile.bat file in notepad and save it.
Open the command window and execute the compile.bat file
COMPILATION  compile.bat
set CPATH=.;C:\j2sdkee1.2.1\lib\j2ee.jar
javac -classpath %CPATH% addremote.java addbean.java addhome.java

[image: ]

STEP 4: Deploy the EJB created with the j2ee deployment tool.
Open the command window and start the j2ee server
C:\> j2ee –verbose
[image: ]
Open another command window and execute deploytool
C:\> deploytool
[image: ]
DEPLOYMENT PROCEDURE
· Choose File New Application. The new application window will be appeared as shown below
· Locate the folder C:\add using Browse button.
· Type AddApp in Application Display Name text field and click OK.
· Choose File New Enterprise Bean. The New Enterprise Bean wizard will be opened.
· Read the instruction and click Next button in the first page of the wizard.
· Type the JAR Display name as AddAppClient in the next page that is shown.
· Click Add button that appear under the Contents area. Add files to .JAR dialog box will be displayed.
· Click Browse button and choose addremote.class, addhome.class and addbean.class.
· Click Add button.
· Click Next button. The next page will be displayed as shown.
· Choose addbean in Enterprise Bean Class combo box.
· Choose addhome in Home Interface combo box.
· Type AddBean in Enterprise Bean Display Name text field.
· Choose session radio button in Bean type and select stateless.
· Click Finish button.
· Choose Tools Deploy Application….The Deploy wizard will be opened as shown.
· Choose localhost in the TargetServer combo box.
· Tick the “Return Client Jar” check box. Type
C:\add\AddAppClient.jar in the text field.
· Click Next button. 
· Give MyAdd in JNDI Name and click Finish
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Now Addition component has been deployed



STEP 5 : Write the Client Code to invoke the Addition component in addclient.java 

//addclient.java
import javax.naming.InitialContext;
import javax.naming.*;
import javax.ejb.*;
import java.rmi.*;
import java.util.*;

public class addclient
{
    public static void main(String s[])
    {
	try
	{
	Properties p = System.getProperties();
	Context c = new InitialContext(p);
	addhome ah = (addhome)c.lookup("MyAdd");
	addremote ar=ah.create();
	System.out.print("Calling Add Component : ");
	System.out.println(ar.add(5,2));
	}
	catch(Exception e)
	{
	e.printStackTrace();
	}
     }
}

 STEP 6 : Compiling  and executing the Client file

Write the compile1.bat file in notepad and save it.
Open the command window and execute the compile1.bat file
COMPILATION  compile1.bat

set CPATH=.;C:\j2sdkee1.2.1\lib\j2ee.jar
javac -classpath %CPATH% addclient.java

EXECUTION run.bat

set CPATH=.;C:\j2sdkee1.2.1\lib\j2ee.jar;AddAppClient.jar
java -Dorg.omg.CORBA.ORBInitialHost=localhost -classpath "%CPATH%" addclient


 
OUTPUT
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EX NO:  2.2   	         TEMPERATURE CONVERSION COMPONENT USING EJB
DATE :

AIM:
     To deploy an EJB Component for converting temperature from Fahrenheit to Celsius.
PROCEDURE:
STEP1:  Write the source code for the remote interface for EJB and save it as Temperature.java
//Temperature.java
import javax.ejb.EJBObject;
import java.rmi.RemoteException;
public interface Temperature extends EJBObject
{
public double FahrenheitToCelsius(double degree) throws RemoteException;
}

STEP2: Write the source code for Stateless Session Bean class and save it as TemperatureEJB.java
//TemperatureEJB.java
import java.rmi.RemoteException;
import javax.ejb.SessionBean;
import javax.ejb.SessionContext;
public class TemperatureEJB implements SessionBean
{
public double FahrenheitToCelsius(double f)
{
double c;
c=((f-32)*5)/9;
return c;
}
public TemperatureEJB() {}
public void ejbCreate() {}
public void ejbRemove() {}
public void ejbActivate() {}
public void ejbPassivate() {}
public void setSessionContext(SessionContext sc) {}
}


STEP 3: Write the source code for home interface called TemperatureHome.java
//TemperatureHome.java
import java.io.Serializable;
import java.rmi.RemoteException;
import javax.ejb.CreateException;
import javax.ejb.EJBHome;
public interface TemperatureHome extends EJBHome
{
Temperature create() throws RemoteException ,CreateException;
}

STEP 4:  Compile all java files by executing compile.bat file. 
COMPILATION compile.bat
set CPATH=;c:\j2sdkee1.2.1\lib\j2ee.jar
javac –classpath %CPATH% Temperature.java TemperatureEJB.java TemperatureHome.java

STEP 5: Deploy the EJB created by the j2ee deployment tool.
DEPLOYMENT
C:\> j2ee –verbose
C:\> deploytool
Deployment tool version 1.2.1 Type deploytool –help for command line options.          Starting………
· Choose File New Application. The new application window will be appeared as shown below

[image: ]

· Locate the folder C:\temperature using Browse button.
· Type TemperatureApp in Application Display Name text field and click OK.
· Choose File New Enterprise Bean. The New Enterprise Bean wizard will be opened.
· Read the instruction and click Next button in the first page of the wizard.
· Type the JAR Display name as TemperatureAppClient in the next page that is shown.
· Click Add button that appear under the Contents area. Addfiles to .JAR dialog box will be displayed.
· Click Browse button and choose Temperature.class, TemperatureHome.class and TemperatureEJB.class.
· Click Add button.
· Click Next button. The next page will be displayed as shown.
· Choose TemperatureEJB in Enterprise Bean Class combo box.
· Choose TemperatureHome in Home Interface combo box.
· Type TemperatureBean in Enterprise Bean Display Name text field.
· Choose session radio button in Bean type and select stateless.
· Click Finish button.
· Choose Tools Deploy Application….The Deploy wizard will be opened as shown.
· Choose localhost in the TargetServer combo box.
· Tick the “Return Client Jar” check box. Type
C:|\Temperature\TemperatureAppClient.jar in the text field.
· Click Next button.
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STEP 6:  Write the source code for the client to invoke the Temperature Component.
//TemperatureClient.java
import javax.naming.Context;
import java.io.*;
import javax.naming.InitialContext;
import javax.rmi.PortableRemoteObject;
import Temperature;
import TemperatureHome;
public class TemperatureClient
{
public static void main(String[] args)
{
TemperatureHome home;
BufferedReader stdin;
try
{
Context initial=new InitialContext();
Object objref=initial.lookup("MyTemperature");
home=(TemperatureHome)PortableRemoteObject.narrow(objref,TemperatureHome.class);
Temperature degreeConverter=home.create();
try
{
double f=0;
while(f!='q')
{
stdin=new BufferedReader(new InputStreamReader(System.in));
System.out.println("\n\nEnter the temperature in Fahrenheit(Type 'q' to Quit):");
f=Double.parseDouble(stdin.readLine());
double cel=degreeConverter.FahrenheitToCelsius(f);
System.out.println("The temperature in celsius:"+String.valueOf(cel));
}
}
catch(Exception e)
{
System.out.println("Thank you");
degreeConverter. remove();
}}
catch(Exception ex)
{
System.out.println("Caught on unexpected exception!");
ex.printStackTrace();
}
}
}

STEP 7: Compile the client file and execute to get the output
COMPILATION  compile1.bat
set CPATH=.;c:\j2sdkee1.2.1\lib\j2ee.jar;c:\j2sdkee1.2.1\Temperature
javac –classpath %CPATH% TemperatureClient.java
EXECUTION run.bat
set CPATH=.;c:\j2sdkee1.2.1\lib\j2ee.jar; TemperatureAppClient.jar
java –D0rg.omg.CORBA.ORBInitialHost=localhost –classpath “%CPATH%”
TemperatureClient




OUTPUT:
[image: ]























EX NO:  2.3   	         RANDOM NUMBER COMPONENT USING EJB
DATE :

AIM:
     To deploy an EJB Component for generating random numbers
PROCEDURE:
STEP 1:  Write the source code for the remote interface for EJB and save it as Count.java
//Count.java
import javax.ejb.*;
import java.rmi.*;
public interface Count extends EJBObject
{
public int count() throws RemoteException;
}

STEP 2: Write the source code for home interface called CountHome.java
//CountHome.java

import javax.ejb.*;
import java.rmi.*;
public interface CountHome extends EJBHome
{
public Count create(int val) throws CreateException,RemoteException;
}

STEP 3: Write the source code for Stateful Session Bean class and save it as CountEJB.java
// CountEJB.java

import javax.ejb.*;
import java.rmi.*;
public class CountEJB implements SessionBean
   {
      private int val;
      public int count()
	{
		return ++val;
	}
      public void ejbCreate(int val) throws CreateException,RemoteException
      {
	System.out.println("ejbcreate is called");
this.val=val;
}
public void ejbActivate() throws RemoteException
{
System.out.println("activate is called");
}
public void ejbPassivate() throws RemoteException
{
System.out.println("passivate is called");
}
public void setSessionContext(SessionContext sc) throws RemoteException {}
public void ejbRemove()
{
System.out.println("remove is called");
}
} 	

STEP 4:  Compile all java files by executing compile.bat file and generate class files. 
compile.bat
set CPATH=.;C:\j2sdkee1.2.1\lib\j2ee.jar
javac -classpath %CPATH% Count.java CountHome.java CountEJB.java

STEP 5: Deploy the EJB created by the j2ee deployment tool. Follow the steps similarly for the deployment process
C:\> j2ee –verbose
C:\> deploytool
JAR FILE NAME : CountAppClient.jar
JNDI NAME : countprogram
STEP 6:  Write the source code for the client to invoke the Count Component.
//CountClient.java
import javax.naming.*;
import javax.ejb.*;
import java.util.*;

public class CountClient
{
public static void main(String s[])
{
try
{
Properties props=System.getProperties();
Context c=new InitialContext(props);
CountHome ch=(CountHome)c.lookup("countprogram");
Count count[]=new Count[3];
int countval=0;
System.out.println("instantiating beans...");
for(int i=0;i<3;i++)
{
count[i]=ch.create(countval);
countval=count[i].count();
System.out.println(countval);
Thread.sleep(500);
System.out.println("calling count on beans");
}
for(int i=0;i<3;i++)
{
countval=count[i].count();
System.out.println(countval);
Thread.sleep(500);
}
for(int i=0;i<3;i++)
{
count[i].remove();
}
}
catch(Exception e)
{
e.printStackTrace();
}
}
}

STEP 7: Compile the client file and execute to get the output
COMPILATION : compile1.bat
set CPATH=.;C:\j2sdkee1.2.1\lib\j2ee.jar
javac -classpath %CPATH% CountClient.java

EXECUTION : run.bat
set CPATH=.;C:\j2sdkee1.2.1\lib\j2ee.jar;CountAppClient.jar
java -Dorg.omg.CORBA.ORBInitialHost=localhost -classpath "%CPATH%" CountClient

OUTPUT :
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EX NO:  2.4   	         ITEM PROCESSING COMPONENT USING EJB
DATE :

AIM:
     To deploy an EJB Component for Item Processing.
PROCEDURE:
STEP 1:  Write the source code for the remote interface for EJB and save it as Stateful.java
// Stateful.java
import javax.ejb.*;
import java.rmi.*;
import java.util.*;

public interface Stateful extends EJBObject
{
public void addItems(String Key, String Value) throws RemoteException;
public Hashtable getItems() throws RemoteException;
public int removeItems(String Key, String Value) throws RemoteException;
}

STEP 2: Write the source code for home interface called StatefulHome.java

//StatefulHome.java

import javax.ejb.*;
import java.rmi.*;
public interface StatefulHome extends EJBHome
{
public Stateful create(int id) throws CreateException, RemoteException;
}

 STEP 3: Write the source code for Stateful Session Bean class and save it as StatefulBean.java
// StatefulBean.java

import javax.ejb.*;
import javax.rmi.*;
import java.util.*;
public class StatefulBean implements SessionBean
{
Hashtable ht;
public void ejbCreate(int id)
{
System.out.println("Inside EjbCreate()");
ht=new Hashtable();
}
public void setSessionContext(SessionContext ctx)
{
System.out.println("Inside SessionContext ()");
}
public void ejbActivate()
{
System.out.println("Inside EjbActivate()");
}
public void ejbPassivate()
{
System.out.println("Inside EjbPassivate()");
}
public void ejbRemove()
{
System.out.println("Inside EjbRemove()");
}
public void addItems(String key, String Value)
{
System.out.println("Inside addItems()");
if (ht.containsKey(key))
{
String value = (String) ht.get(key);
int cvalue=Integer.parseInt(Value)+Integer.parseInt(value);
Value=""+cvalue;
}
ht.put(key,Value);}
public Hashtable getItems()
{
System.out.println("Inside getItems()");
return ht;
}
public int removeItems(String key, String Value)
{
System.out.println("Inside removeItems()");
String value = (String)ht.get(key);
int cvalue=Integer.parseInt(Value)-Integer.parseInt(value);
System.out.println("value"+cvalue);
if (cvalue<0)
{
return 1;
}
else
{
value=""+cvalue;
ht.put(key,Value);
return 0;
} 
 } 
 }
STEP 4:  Compile all java files by executing compile.bat file and generate class files. 
compile.bat
set CPATH=.;C:\j2sdkee1.2.1\lib\j2ee.jar
javac -classpath %CPATH% Stateful.java StatefulHome.java StatefulBean.java 
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STEP 5: Deploy the EJB created by the j2ee deployment tool. Follow the steps similarly for the deployment process
C:\> j2ee –verbose
C:\> deploytool
JAR FILE NAME : ItemAppClient.jar
JNDI NAME : MyItem
STEP 6:  Write the source code for the client to invoke the Item Component in StatefulClient.java
//StatefulClient.java
import javax.ejb.*;
import java.util.*;
import javax.naming.*;
public class StatefulClient
{
public static void main(String args[]) throws Exception
{
Properties p=new Properties();
InitialContext ctx=new InitialContext(p);
StatefulHome home=(StatefulHome)ctx.lookup("MyItem");
Stateful remote=home.create(20);
remote.addItems("CPU","20");
remote.addItems("Keyboard","20");
remote.addItems("Mouse","20");
dowhile(remote);
int c= remote.removeItems("Mouse","10");
check(c);
dowhile(remote);
c= remote.removeItems("Mouse","20");
check(c);
System.out.println("second instance---------------------");
Stateful remote1=home.create(20);
remote1.addItems("CPU","20");
remote1.addItems("CPU","20");
remote1.addItems("Mouse","20");
dowhile(remote1);
c= remote1.removeItems("Mouse","10");
check(c);
dowhile(remote);
c= remote1.removeItems("Mouse","20");
check(c);
}
public static void check(int c)
{
if (c==1)
{
System.out.println("Cannot remove Item");
}
else
{

System.out.println("Mouse Item Removed");
}
}
public static void dowhile(Stateful remote)
{
try
{
Hashtable h=remote.getItems();
Enumeration e=h.keys();
System.out.println("Items"+"\t"+"Values");
while (e.hasMoreElements())
{
String k=(String)e.nextElement();
System.out.println(k+"\t"+h.get(k));
}
}
catch(Exception e)
{
e.printStackTrace();
}
}
}

STEP 7: Compile the client file and execute to get the output

COMPILATION: compile1.bat
set CPATH=.;C:\j2sdkee1.2.1\lib\j2ee.jar
javac -classpath %CPATH% StatefulClient.java

EXECUTION : run.bat
set CPATH=.;C:\j2sdkee1.2.1\lib\j2ee.jar;StatefulAppClient.jar
java -Dorg.omg.CORBA.ORBInitialHost=localhost -classpath "%CPATH%" StatefulClient

OUTPUT
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EX. NO : 3		INVOKE .NET COMPONENTS AS WEB SERVICES
DATE : 

AIM:

To invoke .NET components as Web Services

SOFTWARE REQUIREMENTS:

1. Microsoft Visual Basic 2008

PROCEDURE:

STEP 1: All the components has to be created first, or previously created components can be used.
Component Code (Newly added Component)
· Open New Project and Select Class Library and give the name of the project as NumLib
and enter the code 
Public Class NumLib
    ' Determine the number of factors for n.
    Public Function Factorize(ByVal n As Long) As Long
        Dim lCount As Long
        lCount = 0
        ' Look for factors including 1 and the number itself.
        Dim i As Long
        For i = 1 To n
            If (n Mod i) = 0 Then
                lCount = lCount + 1
            End If
        Next
        Factorize = lCount
    End Function
‘ Determine the Decimal to Binary Value
Public Function dtobin(ByVal decno As Long) As String
Dim rm As Integer
dtob = ""
While decno > 0
rm = decno Mod 2
dtob = dtob & Str(rm)
decno = Int(decno / 2)
Wend
dtob = StrReverse(dtob)
dtobin = dtob
End Function
End Class

Note: Make sure all the components created in Exercise 1 exist in your system from which references can be included

STEP 2: Choose New Project
  Select Web  ASP .NET Web Service Application
              Type Project name as WSNumber
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STEP 3: To invoke .NET components as Web Services 
   Add references to the components like Timer, Temperature, Interest,     CurrencyConverter which were already created 

[image: ]

To make a method as a web service prefix it with <WebMethod()> _



GENERATED FILE :  Web.config






PROJECT : WSNumber.vbproj

Imports System.Web.Services
Imports System.Web.Services.Protocols
Imports System.ComponentModel

' To allow this Web Service to be called from script, using ASP.NET AJAX, uncomment the following line.
' <System.Web.Script.Services.ScriptService()> _
<System.Web.Services.WebService(Namespace:="http://tempuri.org/")> _
<System.Web.Services.WebServiceBinding(ConformsTo:=WsiProfiles.BasicProfile1_1)> _
<ToolboxItem(False)> _
Public Class Service1
    Inherits System.Web.Services.WebService

    <WebMethod()> _
    Public Function HelloWorld() As String
        Return "Hello World"
    End Function
    
    Note : To add the following code 
    <WebMethod()> _
    Public Function FactNum() As String
        Dim fn As New NumLib.NumLib
        Dim f As Long
        f = fn.Factorize(20)
        Return "No of Factors of 10 is " + CStr(f)
    End Function

    <WebMethod()> _
   Public Function CompoundIntrcal() As String
        Dim ic As New InterestComp.InterestComp
        Dim amt As String
        amt = ic.CompoundInt(1000, 5, 3)
        Return "Compound Interest (1000,5,3) is " + CStr(amt)
    End Function

    <WebMethod()> _
   Public Function SimpleIntrcal() As String
        Dim ic As New InterestComp.InterestComp
        Dim amt As String
        amt = ic.SimpleInt(1000, 5, 3)
        Return "Simple Interest (1000,5,3) is " + CStr(amt)
    End Function
End Class
OUTPUT:

[image: ]

[image: ]
[image: ]

[image: ]


[image: ]

[image: ]





EX. NO : 4		INVOKE EJB COMPONENTS AS WEB SERVICES
DATE:

AIM:
 To invoke EJB components as Web Services

SOFTWARE REQUIREMENTS:

Software  :  1. JAXWS2.1.7-20090419.zip
	        2. JDK1.6.0_26

· To unzip JAXWS2.1.7-20090419.zip use the following command 
· C:\> java –jar JAXWS2.1.7-20090419.zip

· The sub-directory  jaxws-ri  will be created
· C:\> cd jaxws-ri 

· Create a working sub directory named arith in jaws-ri

PROCEDURE: 

STEP 1: Open notepad and create the interface code as ArithInt.java

//ArithInt.java
package arith;
import javax.jws.*;
@WebService
public interface ArithInt
{
@WebMethod
public int add(int a, int b);
}

STEP 2: Open notepad and create the implementation code as ArithImpl.java

//ArithImpl.java
package arith;
import javax.jws.*;
@WebService(endpointInterface="arith.ArithInt")
public class ArithImpl implements ArithInt
{
public int add(int a, int b)
{
return a+b;
}
}
STEP 3: Compile the programs

· Set the path variable to the java version 1.6  folder in the Environmental variables
C:\Program Files\Java\jdk1.6.0_26\bin

·   Execute compile.bat file as the following
javac –d  . -classpath "..\jaxws-ri\lib\jsr181-api.jar;.;" ArithInt.java ArithImpl.java

· Subdirectory arith will be generated
· Execute the following command 
wsgen –cp . arith.ArithImpl

· Change to arith directory
cd arith

in arith\arith jaxws directory will be created and two files Add.class and AddResponse.class will be generated

STEP 4: Deploy the Web Component

Open notepad and create WSPublisher.java

//WSPublisher.java
import javax.xml.ws.*;
import arith.ArithImpl;
public class WSPublisher
{
public static void main (String[] args)
{
Endpoint.publish("http://localhost:5000/WS/arith", new ArithImpl());
}
}

STEP 5: Compile and execute the programs

compile1.bat
javac -classpath "D:\Tamilarasi\SOALAB\jaxws-ri\lib\jaxws-api.jar;.;" WSPublisher.java

run.bat
java -classpath "D:\\Tamilarasi\\SOALAB\\jaxws-ri\\lib\\*;.;" WSPublisher

Now Web Server listens at port 5000

STEP 6: In browser type
http://localhost:5000/WS/arith?WSDL
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STEP 7: Write Client Application to test the web service
Open another Command prompt
To generate client side artifacts ArithImplService.class (Stub) in sub directory arith
C:\>wsimport -s .  http://localhost:5000/WS/arith?WSDL
PATH=.;C:\Program Files\Java\jdk1.6.0_26\bin;D:\Tamilarasi\SOALAB\jaxws-ri\bin

STEP 8: Create the Client program ArithClient.java 
import arith.*;
public class ArithClient
{
public static void main (String args[])
{
ArithImplService Service = new ArithImplService();
ArithInt Client = Service.getArithImplPort();
int result = Client.add(12,11);
System.out.print(“Addition of 11 & 12 is  “);
System.out.println(result);
}
}

STEP 9: Compiling and executing  the Client Programs
javac -classpath . ArithClient.java
java -classpath . ArithClient
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OUTPUT:   INVOIKG EJB COMPONENT AS WEB SERVICE
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			CLIENT CALLING WEB SERVICE 
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EX NO: 5		INVOKING EJB COMPONENTS AS WEB SERVICES 
USING NET BEANS IDE
DATE: 

AIM: 

To deploy and invoke an EJB component as web service in Net beans IDE

SOFTWARE REQUIREMENTS:

NetBeans IDE 6.5.1 (Build 200903060201) 
Java: 1.6.0_26; Java HotSpot(TM) Client VM 20.1-b02 
PROCEDURE
STEP 1:  Open Net Beans from Start Menu
STEP 2:  Choose File  New Project  Java EE  Enterprise Application
	    Give the Filename as Test1 and click Next.
	    Click Finish keeping the default settings
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Click Finish

[image: ]


STEP 3:  Right Click on Test1-ejb and select New  Session Bean
               Give the EJB Name as TestEJB 
	   Give the Package as Stateless
	   Check Stateless as Session Type
	   Check Remote for Create Interface
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STEP 4: Right Click on the code area and select Insert Code
              Select Add Business Method 
              Give the name as getMessage and Return Type as String
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STEP 5: Change Return null to “Hello EJB World” within quotes 
/* 
* To change this template, choose Tools | Templates 
* and open the template in the editor. 
*/ 
package Stateless; 
import javax.ejb.Stateless; 
@Stateless 
public class TestEJBBean implements TestEJBRemote { 
public String getMessage() { 
return "“Hello EJB World" ; 
} 

// Add business logic below. (Right-click in editor and choose 
// "Insert Code > Add Business Method" or "Web Service > Add Operation") 
}

Now the EJB Stateless Session Bean Component has been created.



STEP 6:  To invoke the EJB Component created as Web Service, We need to develop a Servlet.
When the Web module is created, by default Netbeans already creates a file called index.jsp in the Web Pages section. Open this file to add a call to the servlet

The code looks like below: 
Right Click on Test1-war  Select Web Pages  Open Index.jsp 
Add code : 
<a href="TestServlet">Click here to call the EJB component</a> 

STEP 7: We must create a servlet called TestServlet, to invoke the EJB component when the link from User Interface is clicked.
	Right Click on Test1-war  Select Web Pages   Select Servlet
	Give the Class Name as TestServlet 
Give the Package as Servlets
	Click Finish and TestServlet.java will be created
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STEP 8: Add Insert Code and Select Call Enterprise Bean
	   Select TestEJBBean and give OK.
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STEP 9:  Do the following changes in the TestServlet.java
· Add these Header file 
import java.io.*; 
import javax.ejb.EJB; 
import javax.servlet.*; 
import javax.servlet.http.*; 
import stateless.TestEJBRemote;

@EJB 
private TestEJBRemote testEJBBean; 

· Change ProcessRequest to goGet at all places

· Remove this part of coding from comment line and change the code from: 

out.println("<h1>Servlet TestServlet at " + request.getContextPath () + "</h1>"); 
To: 
out.println(testEJBBean.getMessage()); 
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STEP 9: Clean and build, then run Main Project
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OUTPUT :
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EX. NO: 8	CREATION OF A BPEL MODULE AND A COMPOSITE APPLICATION
DATE:
AIM:
Create a SOA project with BPEL Module to compose a web service.
SOFTWARE REQUIREMENTS:
NetBeans IDE 6.5.1 (SOA, Web & Java EE)
PROCEDURE:
STEP 1:  Creating a new BPEL Module Project
The following sections use the Synchronous sample project, and provide step-by-step directions for creating a simple BPEL module project, using the Synchronous sample project.
[bookmark: 6nlj8ms84][image: Procedure]To create a BPEL Module Project
· In the NetBeans IDE, choose File > New Project. 
· The New Projects wizard appears. 
· Under Categories, select Service Oriented Architecture.
· Under Projects, select BPEL Module and click Next.

[image: Image displays the New Project dialog box]
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STEP 2:  Creating a BPEL Process Using the BPEL Designer
Now that you have created your XML Schema and WSDL Document, you can create your BPEL process.
· [bookmark: 6nlj8ms88][image: Procedure]To Create the BPEL Process
· In the Projects window, expand your BPEL module project node, right-click the Process Files node, and choose New -> BPEL Process.
The New BPEL Process dialog box appears.
[image: ]
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· In the Name and Location page, enter the project name (for this example HelloWorld) and specify the project location or accept the defaults.
· Click Finish. 
· The Projects window now contains a project node for the BPEL Module project.

[image: ]
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[image: Image shows the New BPEL Process dialog box]

· Enter a name for the process file name (HelloWorldProcess for this example), and click Finish.
· The new BPEL file opens in the Design view of the BPEL Designer.
· If the Palette and Properties windows are not displayed in your current view, click Windows -> Reset Windows on the NetBeans menu.
[image: Image shows the NetBeans IDE displaying the Design
view of the BPEL Designer]

· Add a partner link to the BPEL Process.
· In the Projects window, expand your project's Process Files node and select the .wsdl file (Synchronous.wsdl for this example).
· If not present create new WSDL file and name it as Synchronous.wsdl
· Drag the WSDL file from the Projects window to the left side of the Design view canvas.
· The IDE provides visual prompts to show you where you can drop the selection. 
· The BPEL Editor adds a partner link to the canvas.
[image: ]
· Add a Receive activity to the BPEL Process.
· From the Web Service section of the Palette window, select the Receive activity. 
· Drag the Receive activity to the HelloWorldProcess process box in the Design view canvas, between the Process Start and the Process End activities.
· The Receive1 activity is added to the process box.
· Click the Receive1 activity's Edit icon.
· The Receive1 Property Editor appears.
· On the Main tab, change the value in the Name field to start.
· From the Partner Link drop-down list, choose PartnerLink1.
· The IDE populates the Operation field with NewWSDLOperation.
· Click the Create button next to the Input Variable Field. 
· The New Input Variable dialog box appears. 
· Click OK to accept the default values.
· Click OK to close the Receive1 Property Editor. 
· The Design view displays the new connection between PartnerLink1 and the Start activity in the process box.
[image: ]
· Add a Reply activity to the BPEL Process.
· Select the Reply activity in the Web Service section of the Palette. Drag and drop the Reply to the prompt between the Start activity and the Process End activity in the process box on the design view canvas.
· A Reply1 activity is added to the design view canvas.
· Click the Reply1 activity's Edit icon.
· The Reply1 Property Editor appears.
· On the Main tab, change the value in the Name field to End.
· From the Partner Link drop-down list, choose PartnerLink1.
· The IDE populates the Operation field with NewWSDLOperation.
· To create anew output variable, make sure that Normal Response is selected, and click the Create button next to the Input Variable Field. 
· The New Input Variable dialog box appears. Click OK to accept the default values.
· Click OK to close the Reply1 Property Editor. 
· The Design view displays the new connection between the End activity in the process box and PartnerLink1.
[image: ]
· Add a Assign activity to the BPEL Process.
· Select the Assign activity in the Basic Activities section of the Palette. Drag and drop the Assign to the prompt between the Start activity and the End activity in the process box on the design view canvas.
· The Assign1 activity is added to the design view canvas.
· Select the Assign1 activity and click the Mapper button on the editors toolbar.
· The BPEL Mapper appears.
· Map the paramA node under Variables -> NewWSDLOperationIn -> inputType in the Output pane of the BPEL Mapper, to the paramA node under Variables -> NewWSDLOperationOut -> resultType in the Input pane of the Mapper. To do this, select theparamA node under Variables -> NewWSDLOperationIn -> inputType in the Output pane, and drag your cursor to the paramA node under Variables -> NewWSDLOperationOut -> resultType in the Input pane.
· This assignment copies the input statement into the output.


[image: ]

[image: Image shows the BPEL Mapper as described in context]
[bookmark: ]To save your changes click the Save All icon in the IDE menu bar.




STEP 3 : Creating a Composite Application Project

A BPEL Module project is not directly deployable. You must first add a BPEL Module project, as a JBI module, to a Composite Application project. You can then deploy the Composite Application project. Deploying the project makes the service assembly available to the application server and enables its service units to run.

[bookmark: 6nlj8ms8b][image: Procedure]To Create a New Composite Application Project
· Choose File > New Project (Ctrl-Shift-N).
· In the Categories list choose Service Oriented Architecture, in the Projects list choose Composite Application, and click Next.
· In the Name and Location page, change the project name to HelloWorldApplication, and specify the location of project files.
· To set the new Composite Application the main project as main, leave the Set as Main Project checkbox selected, and click Finish.
· To add the BPEL Module as a JBI module to the Composite Application project, right-click the new Composite Application and choose Add JBI Module. 
· The Select Project dialog box opens.
· Select the HelloWorld project you created earlier and click Add Project JAR Files.
· The Select Project dialog box closes and the HelloWorld.jar file is added to the JBI Modules node of the HelloWorldApplication Composite Application

Building and Deploying the Composite Application Project
· Building a project compiles the BPEL source file and packages the BPEL file and web service artifacts, including WSDL and XSD files, into a JAR archive. Deploying the project compiles the files in the Composite Application project, packages the compiled BPEL and related web service artifacts (including WSDL and XSD files) into an archive, and deploys them to the Application Server.
· [bookmark: 6nlj8ms8e][image: Procedure]To Build and Deploy the Composite Application Project
· Right-click the Composite Application project's node, and choose Build.
· When the build is complete the Output window reports Build Successful. If the Output window is not visible, choose Window -> Output -> Output.
· Right-click the Composite Application project's node, and choose Deploy.
· Deployment has succeeded when you see a Build successful message in the GlassFish tab of the Output window.
· Open the Services window and expand Servers -> GlassFish V2 -> JBI -> Service Assemblies to see your new deployed Service Assembly.
· If you do not see the deployed project, right-click the Service Assemblies node and choose Refresh.
[image: Image shows the new Service Assembly in the Services
window as described in context]

Testing the Composite Application

· You can test your Composite Application project by adding test cases, binding to the operation, supplying input, and then using the tester.
· [bookmark: 6nlj8ms8h][image: Procedure]Test the HelloWorldApplication Composite Application Project
· In the Projects window, expand the HelloWorldApplication project node, right-click the Test node, and choose New Test Case.
· The New Test Case wizard opens.
· Accept the default test case name, TestCase1, and click Next.
· From the Select the WSDL Document page, expand the HelloWorld - Proecss Files node, select Synchronous.wsdl, and click Next.
· From the Select the Operation to Test page, select the Operation1 and click Finish.
· A new TestCase1 node is added under the project's Test node in the Projects window, containing two subnodes, Input and Output. 
· The Source Editor appears containing the Input file, Input.xml 

Note – 
If the Source Editor does not contain a tab for Input.xml, double-click the Input node in the Projects window to open the file.

From the Input.xml tab of the Source Editor, do the following:
Locate the line: 
	
<syn:paramA>?string?<syn:paramA>



Replace ?string? with Hello World, so that the line appears as follows:
	
<syn:paramA>Hello World<syn:paramA>



From the NetBeans IDE menu bar, click Save All.
[image: Image shows the Source Editor containing the
Input.xml as described in context]

In the Projects window, double-click the Output node under Test -> TestCase1.
Output.xml is opened in the Source Editor. Initially, Output.xml is empty until the first test run populates the file. 
In the Projects window, right-click the TestCase1 node and choose Run from the pop-up menu.
When the Overwrite Empty Output dialog box appears, click Yes to accept new output. The first test run populates the Output.xml file displayed in the Source Editor. 

[image: Image shows the Source Editor containing the
Input.xml as described in context]
The test compares the output to the contents of the output file. Because the first run of the test has nothing to compare itself to, the first test fails. Subsequent test runs will compare their output with the contents of Output.xml and should succeed. 
Run the test again.
The test case is compared to the current output file and succeeds. 














EX. NO: 9	DEVELOPING A SERVICE ORCHESTRATION ENGINE USING BPEL 
DATE:


AIM: 
To develop a Service Orchestration Engine (workflow) using WS-BPEL and impleme  service composition for Travel Reservation Service.

SOFTWARE REQUIREMENTS:

NetBeans IDE 6.5.1 (Web & Java EE)

PROCEDURE:

STEP 1 Creating Travel Reservation Service Sample Project.

This sample is a real-world BPEL process sample constructed using the majority of BPEL elements and several partner web services. 
Together with the Travel Reservation Service sample, the wizard creates two other projects, ReservationPartnerServicesApplication and ReservationPartnerServices. These two projects both need to be deployed to the bundled Application Server in order to provide partner web services for the Travel Reservation Service process. 

To create a sample BPEL project: 
· Choose File > New Project (Ctrl-Shift-N). 
· In the Categories list, expand the Samples node and select the SOA node. 
· In the Projects list, select the sample project you want to create and click Next. 
· In the Name and Location page, name the project and specify the location of project files. 
· Click Finish.

The wizard creates two types of projects for the selected sample: a sample BPEL Module project and a sample Composite Application project. You are free to modify the sample business process or add additional BPEL processes to the BPEL Module project. To deploy, test-run, and debug the process, add the sample BPEL project as a JBI module to the Composite Application project. 

[image: ]
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Give the Project Name as TravelReservationService.

[image: ]

STEP 2 : Deploying and Performing Test Runs of BPEL Processes 

2.1 Starting the Server

· To start or stop a local server from the Services window: 
· Open the Services window by choosing Window > Services (Ctrl-5) from the main menu. 
· Expand the Servers node to display the registered server instances. 
· Right-click the server name and choose an action Start from the pop-up menu. 
· When you start a server, start up information is displayed in the server tab in the Output window. 
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Expand JBI folder and Check Service Assemblies to verify the TravelReservationServiceApplication has been registered under the local server.

2.2 Building BPEL Module Projects 
When you build a project, the IDE checks the BPEL source file and packages the BPEL file and related web-service artifacts (.wsdl and .xsd files) into a JAR archive. 
· In the Projects window, right-click the BPEL Module's node and choose Build Project.
Watch for the BUILD SUCCESSFUL message in the Output window. 
· You can also perform a clean build by right-clicking the BPEL Module's node in the Projects window and choosing Clean and Build Project. 
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2.3 Testing the Project

· In the Projects window, expand the TravelReservationService1Application project node, exapand the Test node, and choose any one of the listed services and right click on it and select Run Option.
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Output :
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Output :

[image: ]














EX. NO : 10                SCENARIO BASED TUTORIAL ABOUT USING NETBEANS BPEL, JBI AND WEB SERVICE DEVELOPMENT FEATURES
DATE : 
Reference : http://weblogs.java.net/blog/kalali/archive/2007/05/a_scenario_base.html
NetBeans Enterprise pack 6.5.1 provides several new features in as well as those ones in version 5.5. One of the most important features is related to ESB (Enterprise Service Bus). This article covers some of NetBeans capabilities to develop application based on the SOA paradigm.
 You will see what ESB is and how it can ease development and deployment. I will also show what BPEL is and how it can affect your development, while demonstrating NetBeansâ€™ level of support for ESB and BPEL. Building a scenario-based sample which uses some of NetBeans Enterprise Pack features in the BPEL and ESB area is the final things I will demonstrate.
What can an ESB do for us?
An ESB which can act as a JBI compliant is an infrastructure that manages, monitors or enhances service's capabilities in several ways like providing more connectivity mechanisms which has been added to ESB by binding components. Binding components can interact with resources outside the ESB. For example a JDBC binding component can act like a consumer and poll a database table for new records and whenever new records become available transforms them to a standard message named Normalized Message and sends it to the other participants by using a message router named Normalized Message Router or NMR. Messages that are produced by binding components may require transformation in order to meet business rules or making usable messages for other binding components or service engines. A service engine provides and consumes services within ESB. BPEL service engine which hosts long running business process based on BPEL standard is as a sample of service engine. 
JBI compliant ESBs are based on XML-web services standards and usually support several WS-I standards like WS-Addressing, WS-Security and etc. When you install NetBeans enterprise pack you are adding a wide range of capabilities to your IDE for developing composite applications which are equal to JBI service assemblies. At the same time, installing Enterprise pack will install a version of glassfish integrated with Open-ESB 2.0 that addresses all your needs.
What is BPEL role in your SOA?
I am not going to talk about technical details of BPEL; I would prefer to say what it can do. BPEL allows us to orchestrate some fine grained web services to perform a more coarse grained long lived asynchronous or short lived synchronous business operations. For example you can develop a web service that persists data based on some meta-data which are attached to your data, a web service that check validation against pre-defined rules, a service that sends email to some recipients. Now you can use BPEL and some other features that are provided by BPEL engine to perform a business operation like order saving and customer registration; so BPEL provides us with features that can highly reduce amount of fine grained web services that we develop in our entire enterprise. 
What does NetBeans as a development tools?
NetBeans enterprise pack provides us with a first class designer for BPEL, WSDL and XSD. Another very good feature that is introduced in Enterprise pack 5.5.1 is CASA editor. Composite Application Service Assembly editor let developers to see a high-level view of how the Service Assembly is connected and configured. More importantly, users can modify connections between elements within the Service Assembly. The routing of Service Units and Binding Components can be easily tweaked, or completely redone as it provide visual editor enriched with a component palette for all available artifacts like binding components and service units. 
The Case Study 
In this article I will develop a sample application based on a fictional scenario that shows how we can leverage BPEL and binding components in our development. Here is the scenario; there is a sample store which takes orders from its customer trough a web service. Order will enter into a business process, business process stores the order to local database and checks the order shipping cost, if shipping cost is greater than 1000, the order should be sent to a supplier that handles orders greater than 1000. This supplier has a JMS queue to receive orders. The order shipping cost will be written to an xml file as the second supplier monitors if it is lower than 1000. 
Requirements: 
You will need: most recent version of NetBeans 6.5.1 and Enterprise pack 6.5.1, basic knowledge of Java and NetBeans IDE. 
The following 8 steps are necessary to complete the sample scenario: 
· Create BPEL module project.
· Create a Web service from PURCHASE_ORDER table which is present in NetBeans bundled JavaDB sample Database. 
· Create PlaceOrder, SaveToFile and SendToJMS WSDLs. 
· Create BPEL process. 
· Create Composite Application project.
· Use CASA editor to configure service assemblies.
· Configure application server resources.
· Test the application.
· Conclusion.


Creating the BPEL Module Project 
Click the New Project icon and select the Service Oriented Architecture category; in the projects list, select the BPEL Module and click next; enter OrdersBP as project name and click Finish. 
 Creating web service from database 
NetBeans provides some wizards to create a web service from database table; the generated web service can perform CRUD (Create, Read, Update and Delete) operation on selected table. 
To create a web service from database right click on OrdersBP project and from pop-up menu select File > New > File/Folder...; select Service Oriented Architecture category and in the file type tree select WSDL from Database..., click Next. Type Orders as file name and advance to next step. In this page you should select database that you want to generate a web service from one of its tables; select the sample data source from the list as shown in Figure 1. Username and password for database is app/app if you have not provided NetBeans with them until now. 
As you can see in the wizard page you can add a table from available list to the selected list; just add PURCHASE_ORDER table to selected list and click Next. Now you will see a page that asks you to select table that you want to generate CRUD operation for it as web service operations. 
For now we can just select one table for each wsdl file but in next versions you can select more tables and in this page you can determine which of CRUD operations for which tables you want to be included in the web service. Choose Purchase_Order table and proceed to the next page; this page will ask you about JNDI name for a connection pooling that is configured to provide connections for the same database that you select its table in previous step, type jdbc/soa_sample as JNDI name; we will configure jdbc/soa_sample data source and the connection pooling later. 
[image: image-2.png]
Figure1: select sample data source to create wsdl from one of its tables. 
[image: image-3.png]
Figure 2: choosing Purchase_Order table to create a wsdl from it. 


Creating PlaceOrder, SaveToFile and SendToJMS WSDLs.. 
If you remember the scenario, one of the requirements was communication with the client to receive orders using a web service and the other one was saving the order into a file or sending it as JMS message to a JMS Queue. 
To communicate with client we will create a web service starting from creating its wsdl. So right click on OrdersBP node and select New > WSDL Document... type PlaceOrder for its name and make sure to check import XML schema file(s). We need to import the XSD file to use its definition for order type in our web service. To import the XSD file click Browse and select srcPURCHASE_ORDER.xsd and proceed to the next step. In this step we need to define what is our input message content or type and whether we have output message and fault message for our web service or not. 
For input part: change message part name to inputOrder. We should change the message element to PURCHASE_ORDER element that is created by NetBeans during previous steps. Click on change button in right side of xsd:string; Select Element Or Type window will open, select PURCHASE_ORDER Element as shown in Figure 3. 
[image: image-4.png]
Figure 3: Select element type for inputOrder 
We need to change output message type to the same type that we selected for the input message; so follow the same procedure and change output message type to PURCHASE_ORDER; make sure that you change the part name to outputOrder, click Next, select Document Literal as Binding Subtype and click Finish. 
Now we need to create the two other WSDLs which will connect our BPEL process to File Binding Component and JMS Binding Component. Creating these two files is very simple. I will explain a procedure to create one of them and you create the other one yourself. 
To create SendToJMS WSDL Right click on OrdersBP node and select New > WSDL Document... type SendToJMS.wsdl in the name field and make sure import XML schema file(s) check boxes have been checked, import srcPURCHASE_ORDER.xsd as you did for former WSDL file and proceed to the next step. 
Both of File and JDBC WSDLs have a one way operation because we do not need an output value from them so select One-Way Operation as operation type. Change message part name to inputOrder and change Element or Type to PURCHASE_ORDER as you did for previous wsdl. Click Next, select Document Literal as Binding Subtype and click Finish. 
You may ask yourself what was all of those Binding Subtype available in its combo box, indeed each of the types stands for a Binding Component in Glassfish application server integrated ESB. You can choose any of those Binding type right when you create the WSDL or you can edit it in CASA editor which gives you easier configuration panels. 
To create SaveToFile.wsdl you should follow the same procedure that you followed to create SendToJMS.WSDL. Just make sure that you change the file name to SaveToFile.wsdl. 
Creating the BPEL process file 
As you read earlier in this article we use BPEL to weave our web services and create a more coarse grained business process over them. By now we create three web services which perform some fine grained tasks like inserting data into database, sending messages to JMS and etc; Now we want to create a BPEL process using these web services to perform order processing. 
To create BPEL process, in the Projects window, expand the OrdersBP project node and right click on Process Files node, choose New > BPEL Process. Enter OrderProcess as file name in the New BPEL Process wizard opened window and click Finish. BPEL editor which is one of the bright features of enterprise pack will open and let you design your BPEL. IF Properties and Palette windows are not opened so activate them from Windows menu. 
Now we should add some partner link to our BPEL process, partner links allows BPEL process to communicate with other web services and indeed it allows us to use those web services in BPEL process elements. We need to create four partner links for four web services that we created in previous steps. To create a partner link for the PlaceOrder web service, Drag and Drop PlaceOrder.wsdl from project windows to BPEL designer, a window will opens that let you customize partner link creation, change its name to PlaceOrderPL and click OK and its finished. 
Now our BPEL process should wait until a customer call it with the PlaceOrder web service. So BPEL process should wait until it receives a message from its partner link. From Palette drag and drop a Receive element into OrderProcess in BPEL designer. By Selecting receive element you will see a small envelop appears in its right side, select that envelop and connect it to PlaceOrderPL. By double clicking on the receive element, Property editor window will open click on Create button to create a variable which will carry our order from PlaceOrder web service into the process, accept defaults, select OK for new input variable window again press OK for Property editor. Your Designer should show something similar to figure 5. 
Now we should add a partner link for Orders web services so drag and drop Orders.wsdl from project windows to BPEL designer; Create New Partner Link window will opens, change name field to OrdersPL and click on Swap Roles button to swap partner link role to jdbcPortTypeRole. 
For using previous partner link we used a Receive element to receive messages from it but now we are going to send our messages to this partner link so add an Invoke from Palette to BPEL designer. We want to invoke insert operation of OrdersPL so connect Invoke element to insert operation of OrdersPL. We need to send our order to this operation so we need some variables to carry our order from BPEL process to double click on invoke element, create a new input and output variable and for both of them accept default settings. Click OK to close the property editor. 
[image: image-5.png]
Figure 5: BPEL designer after adding first receive and first partner link. 

Now we have an Invoke element which will invoke Insert operation for us, also we have a variable which will carry our order information to Insert operation. But we need to assign real data to that variable before it can deliver them to Insert operation. Real order data is stored into variable that we defined to receive element in previous step. Assigning variables to each other is responsibility of Assign element in BPEL. So Drag and Drop an assign element from palette between Receive1 and Invoke1 elements; now select Assign1 element and BPEL Mapper will open. Connect variables as shown in Figure 6. 
[image: image-6.png]
Figure 6: BPEL Mapper when mapping variables for assign1 element 
Up to this step, we have received a message from PlaceOrder web service and we store it into database. Now we should decide where we should send the order; if itâ€™s shipping cost is more than 1000, then we have to send it to the JMS queue for first supplier and if it is not that costly shipping we can send it to xml file for second supplier. Here we need to decide based on a condition; so we should use a decision making statement like IF which its markup element is provided in BPEL standard and NetBeans has it in its BPEL palette. 
Drag and drop an IF element from Structured Activities category of palette right after Invoke 1. Select IF element and BPEL Mapper will open, here we can make our Boolean expression based on variables that we have and tens of functions that BPEL Mapper let us use visually. From Operators select a Greater Or Equal, Its icon will appear in middle space of BPEL Mapper. Now connect it to PlaceOrderOperationIn.inputOrder.SHIPPING_COST in left pane and the result in right pane as shown in figure 7. 

[image: image-7.png]
Figure 7: Creating IF condition for shipping cost. 
Select IF Element and in Properties window click on the change button of Condition property. Condition property editor will open; change it according to figure 8. 
[image: image-8.png]
Figure 8:If condition property editor. 
If you are a fan of visual editor and you donâ€™t like to use textual editor even to edit a condition then instead of using property editor that is shown in figure 8 you can add a Number Literal and then link it to any2 in Greater Equal operator; but using condition editor gives you more flexibility to write your condition using sophisticated XPath statements. 
Now we have our decision making statement in place, what we need is a call to appropriated web service in each branch of IF statement. In case that if condition return true then we should send the purchase order to JMS queue and in case that order shipping cost is less than $1000 then we have to send it to the XML file. For both of these operations we need to have partner link to their web services and invoke element to invoke those web services. To involve SaveToFile web service Drag and Drop the SaveToFile.wsdl from Projects window to BPEL editor, Create New Partner Link window will appear. Change partner link name to SaveToFilePL and click on Swap Roles button to change the role of invoker and receiver. Now that we have partner link in place we need to invoke its operation; so drag and drop an Invoke element into BPEL editor.Make sure to put Invoke element in false branch (branch in right side) of IF statement. Connect it to SaveToFilePL partner link. Now we should define input and output variables; so double click on invoke element and create input and output variables with default settings. 
Now drag and drop the SendToJMS.wsdl from Projects window to BPEL editor as we should add latest partner link to our BPEL process. Create New Partner Link window will appear, Change its name to SendToJMSPL and click on Swap Roles button. To invoke SendToJMS operation drags and drop an Invoke element into BPEL editor. Make sure to put Invoke element in true branch (branch in left side) of IF statement. Connect it to SendToJMSPL partner link and to create variables double click on invoke element and create input and output variables with default settings. 
We have two new Invoke elements and variables that carry our information; what we need is to assign some value to these variables. Select Assign1 element in BPEL designer, BPEL Mapper will appear; from right side connect PlaceOrderOperationIn.inputOrder to SendToJMSOperationIn.inputOrder variable in left side to determine what we want to send to JMS queue. Again from right side connect PlaceOrderOperationIn.inputOrder to SaveToFileOperationIn.inputOrder variable in left side to determine what will be stored in our XML file. BPEL Mapper should look like figure 9. 
[image: image-9.png]
Figure 9: BPEL Mapper after mapping all variables in BPEL process. 
Now That the Business process finishes and we want to send reply to initiator in order to confirm that his/her shipping order has been placed. We send back the same order that we received as a confirmation to initiator. So drag and drop a Reply element right before Process End element, connect it to PlaceOrderPL. Now we should define variables and assign what is going to be send as reply; so double click on newly created Reply element and create a normal response output variable with default options. 
Now we should assign the original order to this variable, so select Assign1 element in BPEL designer; BPEL Mapper will appear, from right connect PlaceOrderOperationIn.inputOrder to PlaceOrderOperationOut.outputOrder variable in left side now BPEL Designer should be similar to figure 10. 
[image: image-10.png]

Figure 10: BPEL designer after completing the design. 
Create Composite Application project 
Composite application is our means to create service assembles. These service assemblies will be deployed into our ESB service engines based on their type. Now that we have a BPEL process and we want to deploy it into our ESB we need to create a composite application project to hold our BPEL project module. 
From the IDE's main menu, choose File > New Project. The New Project wizard opens, select Service Oriented Architecture and in the Projects list, select the Composite Application. Proceed to next step and in the Project Name field, type OrdersCA and click Finish. 
Now we need to add our BPEL module to this composite application so in the Projects window, right-click on OrdersCA and choose Add JBI Module from the pop-up menu; when Select Project dialog box opens select OrdersBP project you created earlier in this article and click Add Project JAR Files. Your Projects window should look like figure 11 if you expand all nodes. 
[image: image-11_.png]
Figure 11: Projects window after expanding all nodes. 
About the CASA Editor 
The Composite Application Service Assembly (CASA) editor provides a visual interface to a composite application that allows you to interactively modify the applications's deployment configuration. You can also build the composite application from the CASA Editor. The CASA Editor has two views, Design View and Source View. 
In the Design View, the Palette window is visible. The Palette window allows you to drag and drop WSDL bindings, external Service Units, and connections to a composite application. This allows you to interactively specify WSDL Port configurations and connections between components in the composite application. 

The Source View displays the .casa source file that defines the composite application. This file is read-only in this view. Because this file is generated by the CASA Editor, you should not edit this file. 
Now we can use CASA editor to configure and change our service assemblies. Before going any further, right click on OrdersCA and select Build from pop-up menu. This will initiate OrdersCA.casa file with the current configuration and elements. 
To configure CASA, right click on OrdersCA node in projects window and select Edit, you will see something similar to figure 12. This is CASA editor and you can use it to configure your binding components, service units and endpoints. 
[image: image-12.png]
Figure 12: CASA editor before configuring components binding. 
As you can see in the picture, SendToJMS and SaveToFile are connected to SOAP binding components which is not what we need; delete both SaveToFilePort and SaveToJMSPort from WSDL Ports section. We will add one JMS and one File Binding Component to this part in order to configure using them with SaveToFile and SendToJMS web services. 
To Add and configure File Binding Component drag and drop a fie element from Palette into WSDL Ports section of CASA editor then connect SaveToFile consumer endpoint to the newly dropped File BC's Provider endpoint. CASA editor will give a name to your newly dropped File BC. The name can be something like casaPort1. Select casaPort1; Navigator window has to show casaPort1 elements. If Navigator window is not visible open it from Windows > Navigator menu. Navigator should be similar to figure 13. 
[image: image-13.png]
Figure 13: Navigator window when casaPort1 (File Binding Component) is selected. 
In figure 13 you can see two important elements of casaPort1 marked with Number 1 and Number 2. When you select any of these elements, Properties windows will show customizable property of these elements. File:address element which is marked with number 1 lets you configure file path. This path will be used whether a File BC acts as provider or as consumer. Change the path if it is not suitable for you. file:message element which is marked with number 2 lets you customize how your BC will interact with the file when it acts as consumer or provider. For more information about File BC look at resources section. 
To configure SendToJMS web service end point, drag and drop a jms element from Palette into WSDL Ports section of CASA editor; then connect SendToJMS consumer endpoint to newly dropped JMS BCâ€™s Provider endpoint. CASA editor will give a name to your newly dropped JMS BC the name can be something like casaPort2. Select casaPort2, Navigator window should show casaPort2 elements. If navigator window is not visible open it from Windows > Navigator menu. Navigator should be similar to figure 14. 
As you can see in figure14 jms:address which is marked as number one let you configure connectionURL, username and password. To view and modify properties that are exposed for this element you can use Properties window. For now JMS BC just support SUN MQ. Assuming that you do not changed usename, password and port number of your SUN MQ server; so you have to use settings that are included in table 1. 
[image: image-14.png]
Figure 14: Navigator window when casaPort2 (JMS Binding Component) is selected. 
Elements that are marked with number 2, let you configure how BC should handle your message and deliver it to JMS queue or topic. To select general options of JMS binding component you can use jms:operation element. This element allows you to select topic/queue that you want to use and other JMS connection properties like transaction, delivery mode, time out and etc. If you specify an already created queue (from application server admin console for example) your messages will be delivered to that queue, otherwise Sun MQ will create a temporary queue and save your messages there. Make sure that you have selected jms:message which is marked as number 2 and have changed its textPart property to inputOrder from Properties window. 
		 Property name
	Required value

	connectionURL
	mq://localhost:7676

	username
	admin

	password
	Admin
 



	 


Table 1: Setting required to configure casaPort2 (JMS binding component).
Configuring application server resources 
If you remember, we have used a data source in our initial steps, now we need to create that data source in order to be able to proceed to the next step which is testing our application. To create application server resources open Runtime window in NetBeans IDE and expand Servers node and look for a Green arrow nearby Sun Java System Application Server 9; if green arrow was there, it means that your server is started, otherwise start the server by using provided pop-up menu. After starting application server right click on it and select View Admin Console. 
Login with your username and password (admin/ adminadmin by default) then from left side navigation tree select Resources> JDBC> Connection Pools. Whenever the connection pooling page is opened click on the new button and file in information similar to figure 15. 
[image: image-15.png]
Figure 15: Creating connection pool wizard. 
Now, click next and click finish buttons. Now you should see a table that contains several row, each row identifies a connection pooling that is defined in our application server. Click on soa_sample_pool which is our newly created connection pooling and select Addition Properties tab. Here you should see a table with tens of property value rows; remove all properties and make sure that you have just left properties like figure 16. (Property names and some values are case sensitive) 
[image: image-16.png]
Figure 16: required properties in connection pool advanced tab 
We have a connection pooling ready to be used but before we can use a connection pooling we need to define a JNDI entry for it. We know JNDI entry for connection pooling as data source. To define a data source for soa_sample_pool , from left tree navigate to Resources> JDBC> JDBC Resources. Click on the new button; make sure that field values are similar to figure17. 
[image: image-17.png]
Figure 17: JDBC resource creation. 
Click on OK button. Now you are ready to proceed to latest step in this article. 



Testing composite application 
NetBeans provides a good mechanism to test your Composite application, indeed you just select which method of which end point you want to test and NetBeans will generate SOAP message that you can customize if required and then NetBeans send this message to end point and let you see the result. 
Before proceeding to next step, deploy your project. 
For using NetBeans provided facilities to test your composite application in Project windows expand OrdersCA composite application and right click on Test node, from pop-up menu select New Test Case... A wizard will opens to help you create your test case for this application, Give your test case a name and click on next button. Expand OrdersBP-Process Files node and select PlaceOrder.wsdl. Click on Next button and Select PlaceOrderOperation then click Finish. 
NetBeans will create a test case for your web service. This test case consists of an input and output messages and several messages that are produced as the result of the test case execution. As I said earlier this test case helps you to send a soap message to the web service and check its reply. You can perform some simple load tests over your web service methods using these test cases. 
Double click on input.xml and change its content with listing 1. 
<soapenv:Envelope xsi:schemaLocation="http://schemas.xmlsoap.org/soap/envelope/ http://www.java.net/external?url=http://schemas.xmlsoap.org/soap/envelope/" xmlns:xsi="http://www.w3.org/2001/XMLSchema-instance" xmlns:xsd="http://www.w3.org/2001/XMLSchema" xmlns:soapenv="http://schemas.xmlsoap.org/soap/envelope/" xmlns:tab="http://j2ee.netbeans.org/xsd/tableSchema"> 
<soapenv:Body> 
<tab:PURCHASE_ORDER> 
<tab:CUSTOMER_ID>36</tab:CUSTOMER_ID>
<tab:ORDER_NUM>398571</tab:ORDER_NUM>
<tab:QUANTITY>15</tab:QUANTITY>
<tab:SHIPPING_DATE>2006-07-28</tab:SHIPPING_DATE>
<tab:FREIGHT_COMPANY>Poney Express</tab:FREIGHT_COMPANY>
<tab:SALES_DATE>2006-07-28</tab:SALES_DATE>
<tab:SHIPPING_COST>10000</tab:SHIPPING_COST>
<tab:PRODUCT_ID>986710</tab:PRODUCT_ID>
</tab:PURCHASE_ORDER>
</soapenv:Body>
</soapenv:Envelope>
Listing 1: Sample input message to use as test case input.
 You can execute your test case by pressing ALT+F6 or by pop-up menu that is provided for test case nodes. Result of each execution is an xml file with a date tag as its name; you should see same values that you have entered as input in these files after each execution. Also you should see the same information in an XML file place in the directory that you have configured for file binding component. JMS messages will go to the Queue that you determined or a default named temporary queue. If you are going to execute the test several times make sure to change ORDER_NUM element value as it has a unique constraint.
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[D:\Tani laras i\SOALABN jaxus—riNarith>dir
Uolune in drive D has no label.
Uolune Serial Number is ACAC-E35D
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08,24/2011 conpile bat
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08/24/2011 s “bat
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3 Dirds> 72,202,551,296 hytes

[p:\Tanilaras i\SOALAB\jaxus—riNarith>cd arith

p:\Tani laras i\SOALABNjaxus—riNarithharith>dir
Uolune in drive D has no label.
Uolune Serial Number is ACAC-E35D

Directory of D:\Tamilarasi\SOALABNjaxus-riNaritharith

08/24,2011 18:16 AN <DIR>
08,24/2011 il
08,24/2011 383 ArithInpl.class
08,24/2011 226 Arithint.class
08/24/2011 Jaxus
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Uolune in drive D has no label.
Uolune Serial Number is ACAC-E35D
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08/24,2011 18:16 AN <DIR>
08,24/2011 t.
08,24/2011 897 fdd.class
08/24/2011 756 _AddResponse .class
1,653 bytes
2 Dirds> 72,202,551.296 hytes free

p:\Tani laras i\SOALABNjaxus—riNarithharith>dir
Uolune in drive D has no label.
Uolune Serial Number is ACAC-E35D

Directory of D:\Tamilarasi\SOALABNjaxus-riNaritharith
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\Docunents and Settings\adnindusinport -s . http://localhost:5088,4S Arith?USDY
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“\Docunents and Settings\admin>ed arith
:\Docunents and Settings\admin\arithydir

Uolune in drive C has no label.
Uolune Serial Number is A48C-BFBE

Directory of C:\Documents and Settings\admin\arith

08,/24/2011 <DIRY
08,24/2011 <DIR> :
08,24/2011 711 fdd.class
08,24/2011 1,516 Add: java
08,24/2011 670 AddResponse .class
08,24/2011 1,251 AddResponse . java
08,24/2011 11975 ArithInplService.class
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08,24/2011 635 ArithInt.class
08,24/2011 1,885 Arithint.java
08,24/2011 17411 OhjectFactory.class
08,24/2011 21152 ObjectFactory. java
08,24/2011 224 package-info.class
08/24/2011 83 package-infojava
14,096 hytes
2 Dirds> 78,259,437.568 hytes free

:\Docunents and Settings\adnin\arithd_





image67.png
localhost:5000/WS/arith?WSDL. - Windows Internet Explorer,
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<?xml version="1.0" encoding="UTF-8" ?>
/jax-ws.dev.java.net. RI's version is JAX-WS RI 2.1.7-b01-. =-->
Generated by JAX-WS RI at http://jax-ws.dev.java.net. RI's version is JAX-WS RI 2.1.7-b01-. =->
<definitions xmins:soap="http://schemas.xmlsoap.org/wsdl/soap/" xmIns:tns="http://arith/"
xmins:xsd="http://www.w3.0rg/2001/XMLSchema" xmins="http://schemas.xmlsoap.org/wsdl/"
targetNamespace="http://arith/" name="ArithImplService">
- <types>
- <xsd:schema>
<xsd:import namespace="http://arith/" schemaLocation="http://localhost:5000/WS/arith?xsd=1" />
</xsd:schema>
</types>
- <message name="add">
<part name="parameters" element="tns:add" /> u
</message>
- <message name="addResponse">
<part name="parameters" element="tns:addResponse" />
</message>
- <portType name="ArithInt">
- <operation name="add">
<input message="tns:add" />
<output message="tns:addResponse" />
</operation>
</portType>

oo CIeT
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